UNIVERSITY COURSE APPLIED RADAR REMOTE SENSING

EXERCISE 2 - TUTORIAL

SAR for Land Applications 1 — SAR basics for Land
monitoring using SNAP software
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1 | Exercise outline

In this exercise,we will:

e Learn how to retrieve a land-use / land cover (LULC) classification
based on Sentinel-1 image products

e Explore different types of analysis for the detection of discrete land
cover classes.

e Use supervised and unsupervised classification algorithms to
classify the satellite image into classes
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2 | Background

Mapping land cover using Sentinel-1 data

Mapping land cover using Sentinel-1 data relies on the radar backscatter
signals obtained from the satellite. The backscatter intensity, polarization,
and texture of the radar imagery are analyzed to distinguish between
different land cover types. Supervised classification methods involve
training a dassifier with labeled samples of land cover types, while
unsupervised methods group pixels based on their spectral similarity
without prior training. The accuracy of the land cover classification is
validated using ground truth data, and the results can be refined
iteratively to improve accuracy. The final land cover maps provide valuable

information for various applications, including urban planning, agriculture,

forestry, and environmental monitoring.

Source: https://eodsociety.esa.int/event/7th-advanced-training-course-radar-polarimetry/
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2.1 Study area and data used

For this exercise, we will use two Sentinel-1 images of the same area in
northern Poland, downloaded for year 2023 from the Dataspace
Copernicus Open Access Hub [@https://dataspace.copernicus.eu/].
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However, the feature space of S1 data, referring to the number of
variables available for predicting target classes, is restricted when
compared to optical data. As a result, this tutorial utilizes two images
captured in the same year but during different seasons. This approach
enables the characterization of surfaces based on their temporal
attributes to some extent. Consequently, Image 1 was obtained during
the month with minimal precipitation (February), while Image 2 was
acquired towards the beginning of July, a period associated with the
highest precipitation.
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2.2. SNAP - Open and explore product

Open SNAP Desktop, dick Open Product and open 2 Sentinel-1 GRDH
downloaded products with HH and HV polarizations acquired on 5
February and 11 July 2023 by double click on the zipped folders. The
opened products will appear in Product Explorer window:

S1A_IW_GRDH_1SDV_20230205T050029_20230205T050054_047096_05A661_3C7A.zip
S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371_05EFD9_7392.zip

Click + to expand e.g. the content of product [1] from 5 February 2023,
then expand Bands folder and double click on Intensity_VV band to
visualize it. Depending on your computer's capabilities, this process could
take some time. To minimize the data load, the next step involves
creating a subset that encompasses only a portion of the dataset.

B [1] Intensity_VV - S1A_IW_GRDH_15SDV_20230205T050029_20230205T050054_047096_05A661_3CTA - Z:\Projekty\2023_ESA_ENEUM\07_ucebne_materialy\Radarovy_DPZ\practicals\exercise_ \S1A_IW... — [m] X
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| Product Explorer X | Pixelinfo | =
| E-8 [1] S1A_IW_GRDH_1SDV_20230205T050029_20230205T050054_047096_05A661_3C7A
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#- ([ Vector Data
+- (33 Tie-Point Grids
(@ Quicklooks
=& Bands
[ Amplitude_vH
[ Intensity_VH
i@ Amplitude_vv
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76 [2] S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371_DSEFD9_7392
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Preview of the S1 GRDH product

Note: The image appears inverted because it was captured during an
ascending pass.
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3.1 Pre-processing
We need to apply identical pre-processing steps to both of our scenes:

Create a subset

There is no need to process the whole image, instead, we can reduce the
loaded data to a more manageable size - creating subset. This approach
will decrease processing time in subsequent stages, especially when the
analysis is concentrated on a specific area rather than the entire scene.

; B specify Product Subset X
NaVIQate to RaSter - SUbset tab Spatial Subset Band Subset Tie-Point Grid Subset Metadata Subset
and at Switch to “"Geo Coordinates” .
Pixel Coordinates Geo Coordinates
Enter the following numbers: e e
North latitude bound: 54.70 N =k
West longitude bound: 20.60 s 1
Scene step Y: 1=
South latitude bound: 54.10 e T 24600
East longitude bound: 16.90 e T
T [ Fix full width
] Fix full height
Confirm with Run and repeat the step v
for the second S1 image. "°3”
OK Cancel Help
Apply orbit file

Navigate to Main Menu - Radar - Apply orbit file

In the I/O Parameters tab, select the first product and name the target
product. There is no need to save the output as BEAM-DIMAP (we will save
the time this way)

In the Processing Parameters accept the default settings and select the
option Do not fail if new orbit file not found"

Repeat for the second image.

& Apply Orbit File X & Apply Orbit File b4
File Help File Help
1j0 Parameters  Processing Parameters 1/C Parameters Processing Parameters
5 Product
ouree Froduc Crbit State Vectors: | Sentinel Precise {Auto Download) i
source:
Polynomial Degree: 3

[3] subset_0_of S1A_IW_GRDH_15DV_20230205T050029_202302... ~ | ...

Do not fail if new orbit file is not found

Target Product
MName:
subset_0_of S1A_IW_GRDH_Orb
[ 5ave as: BEAM-DIMAP
Directory:
Z:\Pracovnidlonadllova\ESA_EMELUM\exerdse_8

Open in SNAP

Run Close Run Close
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Note: If precise orbits are not yet available for your product, restituted
orbits can be selected which may not be as accurate as the Precise orbits
but will be betterthan the predicted orbits available within the product

Radiometric calibration
Navigate to Main Menu - Radar - Radiometric - Calibrate

In the I/O Parameters tab, select the product from the previous step
(_Orb) as a source product. For the target product name, add _Cal at the
end of the name as suggested In the case of this final product of
preprocessing, please, save it to your folder for this exercise

In the Processing Parameters accept all default settings and then click
Run.

Repeat for the second image. The saving might take some time.

Note: Thermal Noise Removal is not applied in this tutorial but should be
considered when working with larger subsets or entire images.

&= Calibration X @ Calibration x

File Help File Help

IO Parameters  Processing Parameters

Source Product Polarisations: WH
source: \iS

[5] subset_0_of S1A_IW_GRDH_1SDV_20230205T050029_Orb v

Target Product
MName:
subset_0_of S1A_IW_GRDH_15DV_20230205T050029_Crb_Cal

ENVISAT Auxdliary File: Latest Auxiliary File

Save as: |BEAM-DIMAP v
Directory: Save as complex output
Z:\ESA_RADAR\exercise_2 e Output sigmai) band
Open in SNAP [ output gamma0 band

[] output betad band

Run Close Run Close
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3.2 Coregistration

After both images were radiometrically calibrated in the previous step, the
coregistration brings both into one stack. Image coregistration is the
process that involves aligning two or more images geometrically, ensuring
that corresponding pixels depict the same area on the Earth's surface.
While orbit state vectors alone can suffice to coregister images, for precise
offset tracking, additional data from a digital elevation model (DEM)
necessary to enhance coregistration accuracy.

Navigate to Main Menu - Radar - Coregistration — Coregistration

In the ProductSet-Reader tab, load the last two preprocessed products
(calibrated and with orbit files applied)

In the Write tab name the target product and set the directory to save it
Leave all othersettings as predefined

& Coregistration x €
ProductSet-Reader CreateStack Cross-Correlation Warp  Wirite ProductSet-Reader CreateStack Cross-Correlation warp Wirite
Fie Name: Tyoe  Acauisiton  Track orbit % Number of GCPs: 2000
subset_0_of_S1A_IW_GRDH_1SDV_20230205T050025_Orb_Cal D [o5Feba023  [124 |a7056 [[] Test GCPs are on land Apply Fine Registration for SLCs
subset_1_of_S1A_IW_GRDH_15DV_20230711T050035_Orb_Cal |srD [10u2023 [124 [48371
) Coarse Registration Fine Registration
[[] Estimate Initial Coarse Offset Fine Window Width: 8
= Coarse Window Width: 128 Fine Window Height: 8
Coarse Window Height: 128 - Coherence Threshold:
L 3 Row Interpolation Factor: 3 « jon based re
Column Interpolation Factor: P Fine Accuracy in Azimuth: 2
] Max Tterations: 10 Fine Accuracy in Range: 2
® CP Tolerance: 0.25 Fine Window oversampling factor:
() Coherence based registration
g Use Slicing Windor
Coherence Window Size:
=
2]
%
&
2Products
%) save @ rek [ Run ) save © ren [> Run

Note: If the coregistration fails it is advisable to increase the number of
GCPs and also to have the initial coarse offset estimated by the operator.

In addition to verifying the accuracy of the residuals, it is advisable to
visually inspect the stack's quality. One way to do this is by creating an
RGB representation of both the master and slave products, which helps
determine if the images are properly aligned.

B select RGB-Image Channels X
Right click on the output stack product afe
- Open RGB Image Window: vj& B il
Red:  $0.Sigma0_VV_mst_05Feb2023 o | [
Choose February VV for the red channel, P
Green: | §9.8igma0_VH_mst_05Feb2023 | fane
February VH for the green channel, ——
and JUIy VV for the blue channel. Blue: | $9 Sigma0_VV_sh2_11Jul2023 v|[=
[ fixed range min max

Expressions are valid

[] Store RGB channels as virtual bands in current product

Cancel Help
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Magnify an area featuring distinct surfaces, such as the boundary between
land and water. The RGB image should be vivid and well-defined, except
for alterations in land cover or scattering mechanisms that may have
transpired between the first and second image acquisitions. In the figure,
rivers, roads, and agricultural fields are distinctly depicted in all colors.
White pixels represent high backscatter in all three bands (urban areas),
while black pixels denote low backscatter values in all three bands (water).
Blue pixels signify a slightly shifted shoreline in July compared to February.

B snap = [u] X
le Edit View Analysis Layer Vector Raster Optical Radar Tools Window Help Q- Search (Coi+1

% LA PR AW UGB TBELCTB LT »OQATN y
=] id U d (=) 2 > ‘® ® '® x»® % + 4+ ¥

Product Explorer X | Pixel Info \ — | (B ©Ires x‘
E) a [1] S1A_IW_GRDH_1SDV_20230205T050029_20230205T050054_047096_05A661_3C7A
[2] S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371_OSEFD9_7392
[3] subset_0_of S1A_IW_GRDH_1SDV_202302057050023_20230205T050054_047096_0%
[4] subset_1_of S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371,
[5] subset_0_of S1A_IW_GRDH_1SDV_20230205T050023_Orb

[6] subset_1_of S1A_IW_GRDH_1SDV_20230711T050035_Orb

1abeuepy sade [y Th

Py

9-& [7] subset_0_of S1A_IW_GRDH_1SDV_20230205T050029_Orb_Cal

#-64 [8] subset_1_of S1A_IW_GRDH_1SDV_20230711T050035_Orb_Cal
#-5 [9] subset_0_of S1A_IW_GRDH_1SDV_20230205T050029_Orb_Cal_Stack

<

T T
Navi ion X | Colour Manipulat... | Uncertainty Visu... | World View

® elpppp

1: 32.51‘ V I

X -y - Lat - Lon - Zoom -- Level - Pixel Spacing: --m —-m

Speckle Filter
Despeckling removes thermal noise introduced by the sensor from the

image to remove potential sources of error in analysis.

Navigate to Radar > Speckle Filtering Single Product Speckle Filter. In the
I/O Parameters select the last stack product and in the Speckle-Filter tab,
choose the simple Lee Sigma filter with default window sizes.

& Single Product Speckle Filter x @ Single Product Speckle Filter x
File Help File Help

1j0 Parameters  Processing Parameters /O Parameters Processing Parameters

Source Product Sigmal_VH_mst_05Feb2023
SOUrCe: Sigmal_VV_mst_05Feb2023
[3] subset_0_of S1A_IW_GRDH_15DV_20230205T050029_Orb_Ca... ~ || ... Sigmal_VH_shv1_11Jul2023

Sigma0_VV_shv2_113ul2023
Source Bands: aman_tY_slve_

Target Product
Mame:
subset_0_of 51A_IW_GRDH_1SDV_20230205T050029_Orb_Cal_Stack_Spk
Filter: Lee Sigma v
Number of Looks: |1 "
Directory: . X
Window Size: TuT "
Z:\Pracovnic\onacdillova\ESA_ENEUM
Sigma: 0.9 o
ez Target Window Size: | 3y3 -
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You can compare the image pre and post-filtering by doule-click on the
VV polarizations anfd utilizing the Split Window feature found in the
toolbar. As usual, different types of filters will yield somewhat varied
outcomes.

[ [10] Sigma0_vv_mst_05Feb2023 x| ¥ O [ [9] Sigma0_VV_mst_05Feb2023 x| vy 0O &

1abeuely 1a4eT ([

Ateagr pnpoid &

Y

Jabeueyy ysepy

Lat - Lon - Zoom -- Level - Pixel Spacing: --m —-m

Sigma0 VV before (left) and after (right) application of a speckle filter

Terrain-Correction

Navigate to Radar — Geometric — Terrain Correction — Range Dopler Terrain
Correction. The last step in our graph for image pre-processing is to apply
terrain correction to the product, ensuring that all the pixels are moved to
the right locations (eg if the nadir angle of the image is off, it will align the
pixels correctly so it is closer to a top-down view of the imagery).

Our data are still in radar geometry, moreover due to topographical
variations of a scene and the tilt of the satellite sensor, the distances can
be distorted in the SAR images. We need to apply Terrain Correction to
compensate for the distortions and reproject the scene to geographic
projection.

Navigate to Main Menu: Radar - Geometric - Terrain Correction - Range-
Doppler Terrain Correction

In the I/O Parameters tab set as "Source Product” the velocity product.

In “Target Product”, keep the default name and set the Directory

In the Processing Parameters tab set:

Digital Elevation Model: SRTM 1Sec HGT (AutoDownload)
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Map Projection: In this tutorial, we opt for WGS84 as the Map Projection,
which relies on geographic coordinates (latitude and longitude). However,
for subsequent utilization in a geographic information system (GIS),
projected coordinate systems like UTM (Automatic) could also be chosen.

Keep defaults values for the other parameters. Click Run.

& & Range Doppler Terrain Correction >
File Help File Help
1O Parameters  Processing Parameters 1/O Parameters Processing Parameters

Source Product
source: Source Bands: Sigmal_WH_mst_05Feb2023

[10] subset_0_of_S1A_IW_GRDH_15DV_20230205T050025_Orb_Cal_Stack_Spk vy | Sigma0_VV_mst_05Feb2023
Sigmal_VH_shv1_111ul2023

Sigmal_WV_slv2_113ul2023

Target Product
Name:
subset_0_of_S1A_IW_GRDH_1SDV_20230205T050029_Orb_Cal_Stack_spk_TC

[] save as: |BEAM-DIMAP Digital Elevation Model: SRTM 1Sec HGT (Auto Download) o
Directory: DEM Resampling Method: BILINEAR_INTERPOLATION -
Z:\Pracovnici\onacilova\ESA_ENEUM Image Resampling Method: BILTNEAR_INTERPOLATION -
Open in SNAP Source GR. Pixel Spadngs (az x rg): 10.0(m) x 10.0(m)
Pixel Spacing {m): 10.0
Pixel Spacing (deg): 8.983152841195215E-5
Map Projection: WGS84(DD)
Mask out areas without elevation Qutput complex data
Output bands for:
Selected source band [ oEM [] Latitude & Longitude

[[] inddence angle from elipsoid [] Local incidence angle [ ] Projected local incidence angle

[[] Layover Shadow Mask

[] Apply radiometric normalization
Save Sigmal band Use projected local incidence angle from DEM
Save Gammal band Use projected local incidence angle from DEM
Save Betal band

Auxiliary File (ASAR only): Latest Aundliary File

Close Close
Geocoded image product after Terrain Correction

[# [11] sigma0_vv_mst_05Feb2023 x| > O

Jabeuey Jaie [m h

Areagr pnpoad

JEGETEN =N LIH

lat - Lon - Zoom -— Level — Pixel Spacing: —m —m
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Conversion to dB scale

Sigma0_VV values typically fall within the range of 0 to 1, with mean
backscatter values of 0.07 (VV) and 0.02 (VH). This indicates a prevalence
of dark pixels and a scarcity of bright pixels with higher values, resulting in
diminished visual contrasts from a statistical perspective.

To rectify this and achieve a more standardized distribution of values, the
logarithmic function is applied to the radar image. This transformation
converts pixel values into a logarithmic scale, enhancing contrasts by
shifting brighter values towards the mean while expanding the range of
darker values (as depicted in Figure 18, on the right). The calibrated dB
data typically spans from approximately -35 to +10 dB.

To execute this transformation, right-click on each of the four terrain-
corrected bands and choose Linear to/from dB. Confirm by selecting Yes
to generate a virtual band, denoted by the symbol and the "_db" suffix.
These virtual bands are not physically stored on the hard drive but can still
be displayed based on the underlying mathematical expression.

B [11] Sigma0_vv_mst_05Feb2023 X | v o

[ [11] Sigma0_VV_mst_05Feb2023 db X b=

Sigma0 VV before (top) and after (bottom) conversion to dB scale
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Unsupervised classification

An unsupervised classification serves as an effective method for identifying
and grouping pixels that share similar characteristics.

To initiate the K-Means Cluster Analysis, navigate to Raster >
Classification > Unsupervised Classification and select the terrain-
corrected stack as the input product. In the second tab, specify the
number of clusters as e.g. 5, choose all dB bands as the source bands, and
confirm by clicking Run. This process may take several minutes as the
classifier iterates 30 times, utilizing random cluster centers within the
multi-dimensional feature space to identify pixels with similar properties.

BB K-Means Cluster Analysis * BB K-Means Cluster Analysis *
File Help File Help
I/0 Parameters Processing Parameters 1/0 Parameters Processing Parameters
SO Mumber of dusters: 10
Source product:
[11] subset_0_of S1A_IW_GRDH_1SDV_20230205T050029_Orb_Cal_Stack_Spk_TC | ... AEbSsi s A 30
Random seed: 31415
Target Product Sigma0_vH_mst_05Feb2023
[ Sigma0_\WW_mst_05Feb2023

Sigma0_VH_shv1_111ul2023
shv2_117ul2023
2023

subset_0_of_S1A_IW_GRDH_1SDV_20230205T050029_Orb_Cal_Stack_Spk_TC_kmeans

Sigmal_WV

) Source band names: =
[ Bave as; |BEAM-DIMAP 5

Directory:

Z:\Pracovnid\onadllova\ESA_ENELM Sigma0_W_shv2_11ul2023_db

Open in SNAP ROI-mask:

The output is a product with a single band (class_indices), where each
pixel is assigned to one of the 5 dusters. While these dusters may not
directly represent semantic land cover classes, they exhibit homogeneity in
terms of their backscatter characteristics.

Double click to open the ,class_indices" band under Bands folder. Zoom
into the area and explore the most frequent classes and their distribution.
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As depicted in Figure, you can utilize the Color Manipulation tab to allocate
colors and even labels to these clusters, enabling you to assess how well
they align with general land use and land cover classifications.

Mavigation - [12] clazs_indices | Colour Manipulation - [12] clags_indices X | World’

Label Colour Value Frequency Description
cass_1 | | 53.205%|Cluster 0, Center...
class_2 1 29.475%|Cluster 1, Center...
class_3 16.913%|Cluster 2, Center...
class_4 3 0,397%|Cluster 3, Center...
dass_5 [ 0.010%|Cluster 4, Center...

The benefit of employing an unsupervised cassification lies in its
independence from prior knowledge about the study area or the data, yet
it effectively groups pixels with similar traits. However, the drawback is
that the usefulness of the result heavily depends on the chosen humber of
classes. As illustrated in the example, water is segmented into five distinct
classes (3-7), whereas urban areas are consolidated into a single class (8).
If there is overlap between classes, it may be necessary to opt for a higher
number of clusters and then merge them afterward. Conversely, having too
many classes can complicate the identification of patterns within the data.

Supervised classification

Now, we will perform the one type of supervised classification — Random
forest classification. For this we will create some training data by
identifying polygons containing the different land cover types:

+ Select the last subset product by dicking on it. Navigate to Vector > New
Vector Data Container.

« Create new data containers - e.g. for 5 different classes.

« Start with creating the data container for, e.g. ,class1".Click OK.

The newly created vector data container should appear under "Vector
Data" in the Product Explorer. Now let ‘s start creating training polygons for
these different containers onice type using the Polygon drawing tool:

Product Explorer X | Pixel Info [ — ||@ nures x“ v o
-6 [9] subset_0_of S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371_0SEFDS_7392_Orb_Cal e 1 ’ > \ A g R e &
- [10] subset_1_of S1A_IW_GRDH_1SDV_20230205T050029_20230205T050054_047096_05A661_3C7A_Orb_C X, N
&l subset_0_of S1A_IW_GRDH_1SDV_20230711T050035_20230711T050100_049371_0SEFDS_7392_Orb_Cal_Sp
i (3 Metadata
2@ Vector Data
@ pins
BN ground_control_points
¥ & dass_1
i @ dass_2
BN dass_3
[ 3 dass_4
B dass 5

@-@ Tie-Point Grids
&3 Bands 1
-6 [12) subset_0_of S1A_IW_GRDH_15DV_20230711T050035_20230711T050100_049371_0SEFDS_7392_Orb_C: v | |4

< >

Navigation - [11]RGB | Colour Manipulation - [11] RGB X | World View — |/

@Red (OGreen (O Blue

—— Mame: et
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E Random Forest Classifier

Random forest classifier e e
Navigate to Raster > Classification > | o=

(@) Train and apply dassifier newClassifier

Supervised classification  >RanNdOmM o seasydesster b

Forest Classiﬁer (O) Train on Raster (@) Train on Vectors
Evaluate dassifier
Evaluate Feature Power Set O
Y In the Random_Forest_CIassiﬁer . . Min Power Set Size: |2 Max Power Set Size: |7
select the all Training vectors that we e 0
have created. o v
+ Select at least two Feature bands
(poalrisations)

* Click on RUN.

Feature Selection
Feature bands: Sigmal_) 11012023
1102023

Sigma0_VH_slvi_05Feb2023

The output final product should be now

opened in the Product Explorer T
Window. Double-click on the
.LabeledClasses® band under Bands
folderto visualizeit.

@ Save @ Help [> Run

ﬁ [2] LabeledClasses Xl - O,

Compare the results of supervised and unsupervised classification.

THANK YOU FOR FOLLOWING THE EXERCISE!
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